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Introduction 
 

Welcome to the Modular Merchant Label Editor! 

This manual describes the tools available for operating the Modular Merchant Label Editor application. It is our hope that 

this spiffy little program provides a sophisticated, but easy to use, means for designing shipping labels for use in your 

Modular Merchant store. If you have any questions or suggestions about this application, we encourage you to contact our 

technical support staff. We take feedback from our clients very seriously. Technical support and contact information is 

available at the end of this manual. 

 

And now, let’s learn how to create, upload and print custom shipping labels! 

 

 

About the Label Editor 

 

Overview 

The Modular Merchant Label Editor is a stand alone application that can be downloaded and run on your own computer. The 

editor can be used to design your own shipping label templates. These label templates can then be uploaded to your 

Modular Merchant store and used to produce print-ready labels for your orders, in PDF format. 

 

Labels can be designed to fit any one of a number of standard label sheet formats. You can also design your own custom 

label templates. This allows you to use the label editor with specialty forms that combine a mailing label on the same sheet 

as other shipping documents for the order such as invoices or packing lists. 

 

System Requirements 

The Label Editor application is written in the “Java” programming language. It can be used on any operating system that 

supports the Java engine, including Windows, Macintosh, and Linux systems. Version 2 or better of the Java engine is 

required. The Java engine is free. If you do not have the Java engine installed on your system, you can download it from 

http://www.java.com/en/download/index.jsp 

 

Standard Labels 

The Label Editor includes a collection of standard label templates. If you don’t find a standard template that fits your 

requirements, then you may design your own custom label templates. 

 

 The included label templates are: 

• 2up_plain  - 1 label per order, 2 labels across, 10 labels down - prints customer name and address only 

• 3up_plain - 1 label per order, 3 labels across, 10 labels down - prints customer name and address only 

• 2up_company - 1 label per order, 2 labels across, 5 labels down - prints company name and address and 

customer name and address 

• 2per_order - 2 labels per order, 5 labels down - left label is company and customer name and address, right is 

customer and list of order items 
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Downloading the Label Editor 

 

If you have the Java engine available on your computer, then you are ready to download and install the Modular Merchant 

Label Editor. The Label Editor can be downloaded for free from: 

http://www.modularmerchant.com/downloads/Label_Editor.zip 

 

If you do not have the Java engine installed on your system, you will need to download and install it first. It can be 

downloaded from:  

http://www.java.com/en/download/index.jsp 

 

The Label Editor’s download is a zip file. After you have downloaded it, extract the contents of the zip file to a folder on your 

computer that you specify. This will save the contents of the Label Editor’s zip file in the specified folder. The Label Editor’s 

contents include:  

• The Label Editor program: MM Label Editor.jar 

• The Label Editor Manual (this document): Label_Editor_Manual.doc 

• Example Templates: 2up_plain.xml, 3up_plain.xml, 2up_company.xml, 2per_order.xml 

• Tutorial Template: example.xml 

• Image: smile1.gif (Used in the tutorial template.) 

 

After the files have been extracted, you are done. The Label Editor application does not need to be installed. Double-click 

the icon titled MM Label Editor.jar to launch the Label Editor program. 
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Getting Started with the Label Editor 
When the program starts, you will see a “canvas” divided by red margin lines into several label areas. This shows you the 

size and number of labels for the current setup. See figure 1. 

 

 

Figure 1: A label template split into four sections. Changes 

made to the “live” label in the upper-right quadrant will be 

repeated in each of the other quadrants. This allows you to 

design the label once, but print out many labels per page. 

 

 

 
Big Concept #1: The “Live Area” of the Label Editor Canvas 

When you load a template in the Label Editor, you will find the canvas is mostly gray, with one area highlighted in 

white. (See Figure 1 above.) This white area of the canvas is the “live” area. The live area is equal to the height and 

width of one label. Design your label in this white live area. The changes you make to the live label will be 

automatically repeated in each of the other labels in the gray area of the canvas. This allows you to preview what your 

entire sheet of labels will look like when they are printed out on paper. 

  
 
To change to a different size or style of labels you may click the “Labels” menu and select Label Setup. This will open a 

window in which you can edit the dimensions of the label sheet. You may enter custom dimensions in any of the fields, 

(Figure 2a) or you may select a pre-set layout from the drop down menu at the bottom of the setup dialog box. (Figure 2b) 

 

 
Figure 2a: Entering label sheet dimensions. 

 

Figure 2b: Select a previously saved template. 
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Text and Image Layers 

 

Layers Overview 

Each text block and image added to the label template will be placed on its own layer. Layers can be stacked above or 

below each other, and their location in the stack can be changed using the Layer Tools options in the Editor. 

 

Layers Tutorial Using the Example Template 

You may wish to load the template example into the Label Editor. We will use the example template here to demonstrate 

the features of the editor. After loading the example template, you will notice a page of label areas, only one of which is 

white. The remaining labels are all grey indicating that they will repeat the same layout as the single white label in the 

upper left corner. Layouts that use more than one label per order will grey out the appropriate label areas on the page.  

 

In the white label you will find a text layer that says “Place your text here…” If you click once on that text, a green border 

will appear around it. This shows you the size of that text layer. Notice the four small green squares, or resizing handles, on 

the four sides of the border. (See Figure 3) Click and drag on one of those squares to expand that edge of the text layer to 

make it bigger or smaller. This allows you to adjust the height or width of the text layer to fit any amount of text. Notice 

that changing the size of a text layer does not change the font size of the text within it. Click and drag anywhere within the 

text layer to move it to any location on the page. 

 

 

Figure 3. Text frame and green resizing handles. 

 

To the right of the text layer is a small yellow smiley face image. Click once anywhere on this image to display a border 

around the image layer. Like text layers, image layers can be dragged around the page with the mouse and resized by 

dragging the resizing handles. However, image layers have an extra blue resizing handle in the lower-right corner. Click and 

drag on the blue resizing handle to scale the image larger or smaller to fit the new image layer size. (See figure 4)  

 

 

Figure 4:  

A) Original Image 

B) Scale images using the blue handle 

C) Stretch images using the green handles 
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Because the image is stretched to fit the size of its layer, it is best to use the blue corner resizing handle since that scales 

the picture equally in all directions. Stretching an image by the green handles will cause the image to stretch, and it may 

become distorted. 

 

Sneaky Layer Trick 

In special cases a distorted image is just fine. For example, suppose you want a horizontal line stretching across the entire 

width of your label. You can load a small image of a short line and stretch it horizontally to span the entire width of the 

label, without noticeable distortion. Stretching the line vertically would make it thicker. 

 

More Layer Tricks 

Returning to the example template, if you drag the smiley face image over the top of the text layer, the image will overlap 

the letters. This is because the smiley face image layer is above the text layer. The Layer Tools section of the Editor’s tool 

bar contains a drop down menu listing all of the layers in the template. In the example template, the list of layers includes 

“smiley” and “Text 1”. These are the two layers in this layout. (See Figure 5) 

 

 

Figure 5: Drop down menu of layers. 

 

The “smiley” layer, containing the smiley face image, overlaps the “Text 1” layer because it is higher up in the Layers menu. 

The Layers menu shows the stacking order of all text boxes and images.  

 

 

Figure 6: Move a layer down using the Layer Stacking tool 

 

Leaving the image on top of the text, click the Move Layer Down button (see figure 6). This will move the smiley face image 

layer one position down in the stack. By moving it down in the stack, it is now below the text layer, and the text now 

overlaps the image. In the Layers menu, the layer named “Text 1” is now listed above the layer named “smiley”.  

 

The “double arrow” buttons in the Layer Tools menu will move the selected layer to the top or bottom of the stack. 

 

Tool Tips 

Every button in the tool bar has popup Tool Tips; a brief text description of 

what the button does. Hover the mouse pointer over the button momentarily 

to view the Tool Tip. See Figure 7 at right for an example of a Tool Tip. 
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 Renaming Layers 

To the right of the four Stacking Order buttons is a button that allows you to rename the selected layer. Give each layer a 

descriptive name to easily locate layers when you are working on a complex template with many layers. 

 

 Rotating Layers 

To the left of the Stacking Order buttons is the Rotate Layer button. Each click of this button rotates the selected layer 90 

degrees clockwise, allowing text or images to be printed sideways or upside down. 

 

 Editing Text 

Clicking once on a text layer displays the green border around it. Click on the Edit Text button to put the selected text layer 

into editing mode. (Double clicking on a text layer will also enter editing mode.) In editing mode, the green sizing handles 

are replaced with a red border. When the red border is displayed, the text becomes editable and the Bold Text and Italic 

Text menu buttons become active. (See Figure 8) 

 

 

Figure 8: The Bold Text and Italic Text buttons activate when a Text Layer enters editing mode. 

 

The text editor can change the font face, font size and color, as well as setting the bold and italic attributes. Select a portion 

of the text to make changes to it. If a text layer is in edit mode, (with a red border) but no text is selected, then changes 

will be applied to the entire text layer. 

 

At the right end of the Font Tools tool bar are the three text alignment buttons. They allow you to left-align, right-align, or 

center a block of text. Just as with the other editing buttons, if you select a few lines of text, only the selected lines will be 

aligned. If no text is selected, then the entire contents of the layer will be aligned. 

 

 

 
Things to Remember: Text must be upright to be edited. 

There is one important limitation when editing text: text layers may only be edited when they are in the upright 

position. If you wish to edit a text layer that has been rotated, you must first rotate it back to the upright position, edit 

it, and then rotate back to the desired position. 
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Adding and Deleting Layers 

Text layers can be added in two different ways. The first is to import a text file by clicking Import Text under the Text 

menu, and the second is to create an empty text layer by clicking New Text Layer under the same Text menu item. 

 

Image layers can be added by importing an image. Under the Image menu, click Import Image. You will be prompted to 

browse your computer to select an image file. The Label Editor supports images of the types BMP, GIF, JPG, and PNG. 

 

To delete a layer, click once on it to select it, and then click the delete key on your keyboard or select Delete Layer under 

the Layers menu. In either case you will be prompted to confirm the deletion of the layer. 

 

Grids and Boundaries 

The View menu contains options for customizing the appearance of the Editor’s canvas. The Outlines option will place a 

yellow border around each layer so that you can see the sizes and locations of all the layers, whether active or not. These 

yellow borders do not appear on the printed labels. 

 

The Options option toggles the display of the red margin lines that define the edges of the individual labels in the Editor. 

The margin lines do not appear on the printed labels. 

 

The Grid option toggles the display of grid to help you align the various parts of your label design. The Grid Cell Size option 

sets the size of the squares in the grid, from one-inch blocks down to 1/8th inch blocks. The grid does not appear on the 

printed labels. 

 

If the Snap To Grid option is selected, dragging a layer to a new location on the canvas will “snap” it to the nearest grid 

boundary. Activating this option will not affect layers that are already in place. 

 

The rulers at the top and left edges of the Label Editor canvas area are calibrated in 1/8th of an inch. 

 

Fonts and Bar Codes 

In the Font Tools tool bar you will find a drop down menu of font names. These are the standard fonts found on your 

computer that are supported by the Label Editor. Most installations of the Windows operating system also include several 

bar code fonts, which will allow you to print machine-scannable bar codes on your labels. These Windows barcode fonts are 

also supported by the Label Editor. 

 

If you would like to include your company name or other fixed information using a specialty font you might consider 

preparing an image of the text and including it in that manner.  

 

On-Screen Display vs. the Printed Page 

Note that the Label Editor renders its content on-screen in HTML format, but labels will be printed in PDF format. The two 

formats will normally appear virtually identical, but there are some conditions under which the PDF labels might produce 

unexpected results. For example, in the label editor, if a text layer is not large enough to hold all of the text, the letters may 

be partially clipped at the edges of the layer. However, the PDF document may react not by clipping the text, but by 

ignoring all of the text in that layer! If you test a new label layout and find that one or more text layers are missing, you 

may need to load the template into the label editor and slightly enlarge the size of the text layer. This seems to occur most 

often with text layers containing barcode fonts. 
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How Many Labels Per Order? 
 

Naturally, when you print labels for the orders in your store, you will want to fit as many labels as possible per page. It’s 

just human nature.  So far, we’ve worked with the example template, which is designed to print one label for each order. 

For example, if you want to print labels for ten orders, and feed a label sheet through your printer that has ten adhesive 

labels on it, the print job will fill one entire sheet of labels. 

 

But, there may be cases where you want to print two or more labels for each order. For example, you may wish to use one 

label as the address label affixed to the box, plus a second label with a different format to affix to a return envelope.  

 

To accomplish this, the white “live” area of the Label Editor’s canvas will need to include more than one label. The number 

of labels to be included in the canvas’ live area can be set in the following location: Under the Labels menu, select the Label 

Setup option. Then, in the Label Setup popup window, enter the desired value in the Labels Per Order field. (See Figure 2a) 

Below are few examples to clarify how this works… 

 

 

Figure 9: In this example, each order will be printed on one label. The labels repeat across and down the sheet of labels. 

 

 

Figure 10: In this example, two labels (a label to be affixed to the box on the left, and a label listing the order’s inventory 

on the right) will be printed for each order. The labels repeat down the sheet. 
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Integrating Modular Merchant Order Data Into Your Labels 
 

Quick Code Tags 

Labels would not be much use if they always printed the same unchanging text. The label editor allows you to insert special 

tags called QuickCode tags into your label templates. When the labels are actually printed, each of the QuickCode tags will 

be replaced with the appropriate order data from your store records. For example, using the QuickCode tag  

{CUSTOMER NAME} in a text layer will result in the actual customer’s name being printed in that location on each label. 

 

 The QuickCode tags supported by the Label Editor are: 

• {COMPANY NAME} = The name of your company as set in your store’s System Settings. 

• {COMPANY ADDRESS} = Your mailing address, as set in your store’s System Settings. 

• {COMPANY PHONE} = Your company phone number, as set in your store’s System Settings. 

• {CUSTOMER NAME} = The first and last name of the customer associated with the order. 

• {CUSTOMER ID} = The System ID (SID) number of the customer associated with the order. 

• {CUSTOMER SHIP ADDRESS} = The complete shipping address associated with the order. 

• {CUSTOMER SHIP STREET} = Line 1 and Line 2 (if available) of the shipping address associated with the order. 

• {CUSTOMER SHIP CITY} = The city from the shipping address associated with the order. 

• {CUSTOMER SHIP STATE} = The two-character OSI code from the shipping address associated with the order. 

• {CUSTOMER SHIP ZIP} = The zip code from the shipping address associated with the order. 

• {DATE} = Today’s date in MM/DD/YYYY format. 

• {NOTES} = The notes on file for the order, if any. 

• {ORDER ID} = The Order ID number associated with the order. 

• {ORDER INVENTORY} = A list of all of the products associated with the order. 

• {SHIP METHOD} = The shipping method associated with the order. 

 

Open, Save and Upload 

Under the File menu you will find the usual assortment of New, Open, Save, and Save As… menu items. These all work in 

the usual manner, saving and loading template files to your computer.  

 

Additionally, there is an Upload menu item which will upload a saved template file to your Modular Merchant store, so that it 

will be available when printing shipping labels from within your store’s administration area. If your label template includes 

images, they will be embedded into the uploaded template file. Images used in your template do not need to be uploaded 

separately. When you choose to upload a template file, you will be asked to log in to your Modular Merchant account.  

(See Figure 11) 

 

Figure 11: Logging in to your Modular Merchant account from within the Label Editor to upload a label template. 
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The login prompt is necessary for security reasons. It prevents unauthorized users from uploading files to your account. 

When asked to login, you will need to supply your Modular Merchant account name and the user name and password of 

your store administrator account. Anyone for whom you have created an administrator account will be able to upload label 

templates to your account. 

 

Printing Shipping Labels from within your Modular Merchant Administration area 

Once your label template(s) have been uploaded to your Modular Merchant account, they are ready for printing!  

 

To set a label template for use in your store, first, select it from your list of templates in your store’s System Settings. The 

System Settings are located in your store’s administration area at: [Navigation Menu > Admin > System Settings]. 

(See Figure 12) 

 

 

Figure 12: Select a label template in your store’s System Settings. 

 

Next, select an order or a series of orders you with to print shipping labels for. There are several locations within your 

store’s administration area from which to do this. For example, a series of orders can be selected on the Search Orders 

page. After selecting a series of orders, select Print Shipping Labels from the options menu below the list of orders, and click 

the Go button. (See Figure 13) 

 

 

Figure 13: Select orders on the Search Orders page, and then select Print Shipping Labels from the options menu. 

 

Clicking the Go button will open a popup window containing a PDF document of labels. Inspect the labels to ensure their 

quality, and then print the PDF document. The PDF document may also be saved to your computer for storage, or reprinting 

at a later date. 
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Modular Merchant: Terms of Service 

 
Modular Merchant 

 

Developed by 

Stepping Stone Media, LLC 

1126 Gateway Loop 

Suite 118 

Springfield, OR 97477  

 

www.ModularMerchant.com 

support@modularmerchant.com 

 

This document and the software described by this document are copyright 2001-2007 by Stepping Stone Media, LLC. All 

rights reserved. Use of the software described herein may only be done in accordance with the License Agreement provided 

with the software. This document may not be reproduced in full or partial form except for the purpose of using the software 

described herein in accordance with the License Agreement provided with the software. Information in this document is 

subject to change without notice. Companies, names and data used in the examples herein are fictitious unless otherwise 

noted. 

 

Modular Merchant is a trademark of Stepping Stone Media, LLC. All other trademarks are the property of their respective 

owners. This document was developed and produced in Eugene, Oregon, USA. 

 

STEPPING STONE MEDIA, A LIMITED LIABILITY COMPANY, WILL NOT BE LIABLE FOR (A) ANY BUG, ERROR, OMISSION, 

DEFECT, DEFICIENCY, OR NONCONFORMITY IN SOFTWARE OR THIS DOCUMENTATION; (B) IMPLIED MERCHANTIBILITY OF 

FITNESS FOR A PARTICULAR PUPOSE; (C) IMPLIED WARRANTY RELATING TO COURSE OF DEALING, OR USAGE OF TRADE 

OR ANY OTHER IMPLIED WARRANTY WHATSOEVER; (D) CLAIM OF INFRINGEMENT; (E) CLAIM IN TORT, WHTHER OR NOT 

ARISING IN WHOLE OR PART FROM STEPPING STONE MEDIA, LLC’S FAULT, NEGLIGENCE, STRICT LIABILITY, OR PRODUCT 

LIABILITY, OR (F) CLAIM FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES, OR LOSS OF 

DATA, REVENUE, LICENSEES GOODWILL, OR USE. IN NO CASE SHALL STEPPING STONE MEDIA LLC’S LIABILITY EXCEED 

THE PRICE THAT LICENSEE PAID FOR MODULAR MERCHANT SOFTWARE LICENSE. 

 
Use of this documentation and software implies acknowledgement and acceptance of the Modular Merchant Terms of 

Service agreement. This Terms of Service agreement is available online at: 

http://www.ModularMerchant.com/TOS/ 

 
 

 


